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ISSUE: 

Corrupted features can sometimes lead to performance issues and 

unexpected behavior. 

SOLUTION: 

Regularly maintaining your drawings and program performance tasks 

helps minimize the risk of file corruption, reduces the drawing size, and 

improves performance. It's advisable to perform these tasks 

consistently and frequently.  

A list of custom MDT tools and standard AutoCAD tools are available 

to help with maintaining drawings. Corrupted drawings can often be 

recovered with the provided AutoCAD commands. 
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QUICK REFERENCE 
 

DRAWING MAINTENANCE  

Commands within Autodesk Civil 3D: 

1. MDTDWGCLEAN - Cleans drawing and fixes errors 

2. AUDIT - Evaluates the integrity of a drawing and corrects some errors 

3. MDTPURGEALL - Removes all unused items 

4. PURGE 

5. DELETE DUPLICATE OBJECTS - Removes overlapping, duplicate geometry 

6. QSELECT - Locate Redundant Objects 

7. ZOOM EXTENTS - Remove Unneeded Objects 

8. RECOVER – Repair Drawings 

9. WBLOCK – Delete Corrupt Data 

 

WORKING WITH XREFS 

Improve performance in drawings with xrefs: 

1. Unload xrefs that aren’t currently being used. 

2. Detach unloaded xrefs if not needed. 

3. Use Overlay instead of Attach 

4. Use Relative Paths  

5. Check drawings for orphaned (missing) xrefs.  

 

PROGRAM PERFORMANCE & TROUBLESHOOTING 

1. Reboot Computer Daily 

2. Exit Autodesk Desktop Connector 

3. Clear Temp Files 

4. Reset Settings to Default 

5. Remove Current (MDT) Profile 

6. Report Autodesk Errors 
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DRAWING MAINTENANCE 

Keeping drawings free of unneeded data is a necessary task to prevent drawings from 

becoming too large and/or possibly corrupt. Drawing maintenance should be 

performed on a regular basis.     

 

MDT DRAWING CLEAN  

MDT Drawing Clean is a convenient way to run a string of commands that will clean up 

a drawing by fixing errors and removing unused and/or unseen objects. It automates the 

process instead of running commands one by one. A clean drawing will open and save 

quicker, use less memory, and perform faster.  

Run frequently! 

Type MDTDWGCLEAN at the command line or press the DWG Clean from the MDT 

Tools ribbon.  

1. A dialog will appear. This drawing will be saved during the DWG Clean 

process; Do you want to continue? Yes or No?  

a. Click “Yes” to continue. Message appears: “Audited drawing to fix 

errors. Removed: zero-length geometry, empty text objects, orphaned 

data, and unreferenced registered applications.” 

i. Click “OK” to exit. 

ii. (Optional) Press <F2> on keyboard to open the AutoCAD Text 

Window to see results.  

b. Click “No” to cancel.  

i. Process will be cancelled. Command will exit.  

 

* Note: These tools are included in the MDTDWGCLEAN command but may be used 

separately. 

• *AUDIT 

The Audit command evaluates the integrity of a drawing and corrects some 

errors. 

 Applications Menu > Drawing Utilities > AUDIT 

(or type AUDIT on the command line) 

When the routine is done, it will give you a status report of how many objects it 

audited and how many errors it found and corrected.  Running Purge prior to an 

Audit may reduce the number of auditing items. 
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• MDT PURGE ALL 

The MDT Purge All command removes unused items from the drawing, including block 

definitions, detail view styles, dimension styles, groups, layers, linetypes, materials, 

multileader styles, plot styles, shapes, text styles, multiline styles, section view styles, 

table styles, and visual styles. This can help improve the drawing’s performance and 

reduce its file size.  

CAUTION: All unused items will be removed automatically. To choose specific items to 

remove, exit this command and use the AutoCAD PURGE command instead.  

1. Type MDTPURGEALL at the command line or press the Purge All Unused 

from the “MDT Tools” ribbon.  

2. Do you want to continue? Yes or No?  

a. Click “Yes” to continue.  

i. All unused items will be removed.  

ii. Click “OK” to exit.  

iii. (Optional) Press on keyboard to open the AutoCAD Text Window to 

see results.  

b. Click “No” to cancel.  

c. Process will be cancelled. Command will exit. 

 

ADDITIONAL CLEANUP TOOLS 

Civil 3D offers built‐in tools that can be used individually for specific tasks to handle 

specific cleanup tasks.  

• PURGE 

The PURGE command removes selected unused layers, blocks, styles, etc., and 

nested items from the drawing. 

  Applications Menu > Drawing Utilities > PURGE 

(or type PURGE on the command line) 

 

• DELETE DUPLICATE OBJECTS 

Delete Duplicate Objects removes duplicate geometry as well as overlapping 

lines, arcs, and polylines. It also combines partially overlapping or contiguous 

ones. 

Ribbon Tab: Home > Modify > Modify > DELETE DUPLICATE OBJECTS  
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• LOCATE REDUNDANT OBJECTS 

QSELECT is a great tool for finding redundant objects in a drawing, especially if 

you have a rough idea of what should be in your drawing. QSELECT creates a 

selection set based on filtering criteria. 

For example, if you know there should only be one alignment in the drawing, you 

can use QSELECT to select all alignments. If more than one is shown, you’ll 

know there are extras alignments to clean up. 

Ribbon Tab: Survey > General Tools > QUICK SELECT 

(or type QSELECT on the command line) 

• REMOVE UNNEEDED OBJECTS 

Using the ZOOM EXTENTS command is a fast way to see if there’s anything 

outside the main drawing area. Delete random or unwanted objects to clean up 

drawings and reduce the file size. 

Ribbon Tab: Home > View > Navigate 2D > EXTENTS 

(or type ZE on the command line) 

• REPAIR DRAWINGS 

Use the RECOVER command when a drawing file is corrupt to repair damaged 

data in a drawing.  

1. Open AutoCAD (but don’t open the damaged file yet). 

2. Click  Application menu > Drawing Utilities > RECOVER 

3. Browse to the damaged drawing file. 

• DELETE CORRUPT DATA 

If your drawing is corrupted and other fixes don’t work, try using the WBLOCK 

command to save everything into a new file. This can eliminate corrupt data and 

reduce the file size. 

Things to keep in mind when using WBLOCK with Civil 3D: 

1. Don’t set an insertion point – doing so will shift the coordinates. 

2. Use Design Center (Ctrl+2) to drag and drop layouts into the new drawing. 

3. For large or complex Civil 3D objects, WBlock might not be enough. 

a. Export to LandXML, then import into a new drawing. 

b. Export to AutoCAD, which explodes Civil 3D objects. Use the 

resulting lines and shapes to rebuild objects. 
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WORKING WITH XREFS 

Drawings with xrefs can take a long time to open and perform slowly. The following best 

practices are recommended to ensure loading, navigation, and editing remain efficient: 

1. Unload xrefs that aren’t currently being used. When needed, reload the xrefs. 

2. Detach unloaded xrefs if not needed. 

3. Use Overlay instead of Attach whenever possible. Attached xrefs can get 

nested, which slows down performance. 

4. Use Relative Paths when sharing drawings. This lets others store project folders 

wherever they want, if the folder structure remains the same the xrefs will still 

work. 

5. Check drawings for orphaned (missing) xrefs. AutoCAD will search for orphaned 

xrefs until it times out and causes drawings to open slower. 

 

PROGRAM PERFORMANCE & TROUBLESHOOTING 

REBOOT COMPUTER DAILY 

Reboot your computer regularly, either at the beginning of the day or at the end of 

the day. Civil 3D caches information locally as you're working in it throughout the day. 

Restarting your computer will clear the cache and ensures that the programs operate as 

expected. If you do not restart your computer, you will find that Civil 3D can become 

slow and laggy. Civil 3D may freeze entirely or may consistently crash. Issues like this 

can be indicators to restart your computer. 

EXIT AUTODESK DESKTOP CONNECTOR  

Upon user signing off or shutting down the computer, Autodesk Desktop Connector 

(DC) prevents the completion of sign out. The DC takes some time to close - this is “as 

designed” behavior. Choosing “Sign out anyway” is not advisable, as it could disrupt any 

ongoing tasks in the Autodesk Desktop Connector.  

To prevent this from happening, close the DC before logging off or shutting down the 

computer. It’s recommended to wait for the DC app to close. The DC is in the System 

Tray or on the Task Bar at the bottom right corner of the screen. Right click on the DC 

from the system tray and choose Exit before logging off. Make it a habit to close the 

DC before “Shut down or sign off”. 

CLEAR TEMP FILES 

The Temp folder is for Autodesk temporary files. Close Civil 3D. Run the Clear Temp 

Files batch file to delete temp files from the Temp folder. The batch file is in 

C:\mdoh\StateKit\Civil 3D\20XX\Tools.  
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RESET SETTINGS TO DEFAULT 

If the issue seems program-related rather than drawing-related, Reset Settings to 

Default (from start menu) will restore Civil 3D settings. Run this following significant 

performance, crashing, and other issues. The MDT State Kit must be reinstalled after 

the reset. 

1. Close Civil 3D. 

2. Click on the Windows Start menu  (or Search) type “Reset Settings to 

Default”  

3. Navigate to the Autodesk Civil 3D 20xx folder 

4. Click the Reset Settings to Default App 

.  

REMOVE CURRENT PROFILE 

For various reasons, an AutoCAD profile may need to be reset: to fix an error or user 

interface issue, to restore settings that were changed, or to load a more current version. 

 

The Remove Current Profile command will remove the Civil 3D user profile that is set 

current and then close Civil 3D. The removed profile is then able to be cleanly restored 

from file. This command can be used to restore the MDT Civil 3D State Kit profile, 

“MDT_20XX”. (20XX = Civil 3D version in use; 2024, 2025, 2026, etc.) 

 

1. SAVE and close any open drawings. 

2. Type MDTRemoveCurrentProfile at the command line or select the Remove 

Current Profile on the MDT Tools ribbon. 

3. Message appears “You are about to remove the current profile and exit Civil 3D. 

Do you want to proceed? Yes or No?” 

a. Click “Yes” to remove the current profile. 

b. Current profile will be deleted, and Civil 3D will close. 

c. Click “No” to abort. 

i. Command will exit. 

4. Open Civil 3D using the Civil 3D 20XX Montana Desktop Shortcut.  

5. If this shortcut is used, Civil 3D will open and automatically restore the 

MDT_20XX profile. 
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REPORT AUTODESK ERRORS 

When Autodesk encounters a problem and shuts down unexpectedly, report the errors. 

When this happens, you should be prompted to save each open drawing that has 

unsaved changes. These drawings will have "_recover" appended to their names to 

ensure the previously saved drawing file is not overwritten. 

 

After saving any open drawings with unsaved changes, the AutoCAD Error Report 

dialog box should be displayed. From this dialog box, you can send an error report to 

Autodesk. The error report includes information about the current state of the program 

and your workstation and can include optional information, such as what you were doing 

at the time of the error. Error reports are used to improve the stability of the product. 

MDT meets quarterly with Autodesk to review error reports submitted by MDT users. 

The error reports can help troubleshoot issues related to MDT users.  

 

SUPPORT CONTACT: 

Please submit an MDT Engineering Systems CADD Support Request for assistance. 

MDT internal users may Open a Case via the MDT Service Desk. 

 


